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why threads?

poll



speed
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typical problems?

poll
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typical problems? 
typical solutions?

poll



locks



locks are bottlenecks
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performance 
needs

threads

bottlenecks

locks

threading issues

safety
correctness
complexity
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goals

concurrent code ~ sequential code 
	 “structured programming”, but for concurrency 

make concurrency reasonable
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work in progress
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Concurrent programming 1
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operations

a program is a set of interconnected operations

statement

cond

statement

cond

statement

statement

statement

statement
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1. use of abstractions

abstractions can be used as operations
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2. recursive decomposition

a program can be recursively decomposed into operations 
(operations nest)
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3. regular shape

operations have one entry point, and one exit point
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4. local reasoning

 within a scope, one can arrange the operations in a way that 
enables local reasoning
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5. soundness and completeness

all programs can be written in a way that respect the above 
laws
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concurrency
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happens-before

a < b
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sequential program

total ordering on operation execution
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concurrent program

partial ordering on operation execution
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modeling 
concurrency
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3 execution possibilities

a < b 
b < a 

¬(a < b) ⋀ ¬(b < a)

at runtime
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a

b

a

b

b

a

1) 2)

3)
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concurrency 
(design time)

expressing execution constraints 
ignoring actual execution
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basic concurrent constraints

a < b 
b < a 

(a < b) ⋁ (b < a) 
¬(a < b) ⋀ ¬(b < a)

mutual exclusion
concurrent execution

design time
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a

b

a

b

concurrent execution

design time

a

b

a

b

mutual execution

a < b b < a
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advanced concurrent constraints

conditional concurrency 
(sometimes exclusion, sometimes concurrent) 

more than 2 operations
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focus

local constraints 
non-dynamic constraints
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100%

there is nothing more to concurrency
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structured concurrency

concurrency doesn’t contradict structured programming
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implementation 
notes
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thread conservation

one thread in, one thread out
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stack conservation

one in stack, one out stack 

(out stack >= in stack)
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thread-stack relation

one thread, one stack
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number of active threads

the number of stacks that can vary at the same time
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logical thread

variation of stack pointer over time
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abstract out the OS threads
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Hylo 2
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Hylo programming language

fast by definition 
safe by default 
simple

www.hylo-lang.org

http://www.hylo-lang.org
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builds upon the best parts from C++

value semantics 
pass by value, without copy 
copies & moves are explicit 

consuming move semantics 
rules for capture access w/o consuming
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Mutable Value Semantics
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Swift

w/o reference semantics
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Rust

w/o lifetime annotations
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functional

with controlled mutation
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value semantics

template <typename T> 
void append2(std::vector<T>& destination, const T& value) { 
  destination.push_back(value); 
  destination.push_back(value); 
} 

std::vector<int> data; 
… 
append2(data, data[0]); 
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value semantics

fun append2<T>(_ destination: inout Array<T>, _ value: T) { 
  &destination.push_back(value) 
  &destination.push_back(value) 
} 

var data: Array<Int> 
… 
append2(&data, data[0])     // ERROR 
let value = data[0].copy() 
append2(&data, value)       // OK 

copies & moves
are explicit
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law of exclusivity

no simultaneous read + write access 
no simultaneous write + write access 

read + read = ok
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no spooky action at a distance 

local reasoning
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3Expressing concurrency
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Hello, concurrent world!

fun concurrent_greeting() { 
  var f = spawn { 
    print("Hello, concurrent world!") 
  } 
  // do some other things... 
  f.await() 
} 
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T2

T3

T1 T4 T5

task relations
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task relations

fun task_relations() { 
  print("T1") 
  var f = spawn { print("T3") } 
  print("T2") 
  f.await() 
  print("T4") 
  print("T5") 
} 
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T2

T3

T1

T6

T13

T4

T5

T7

T8

T9

T10

T11

T12

T14

T15

T16

T17

T18
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fun run_work() -> Int { 
  var sum = 0 
  &sum += run_task(1) 

  var f2 = spawn_(fun[] () -> Int { 
    var local_sum = 0 
    &local_sum += run_task(2) 

    var f = spawn_(fun[] () -> Int { return run_task(7) }) 
    &local_sum += run_task(6) 
    &local_sum += f.await() 

    &local_sum += run_task(13) 
    &local_sum += run_task(17) 
    return local_sum 
  }) 

  var f3 = spawn_(fun[] () -> Int { 
    return run_task(3) + run_task(8) 
  }) 

  var f4 = spawn_(fun[] () -> Int { 
    var local_sum = 0 
    &local_sum += run_task(4) 

    var f = spawn_(fun[] () -> Int { return run_task(10) }) 
    &local_sum += run_task(9) 
    &local_sum += f.await() 

    &local_sum += run_task(14) 
    return local_sum 
  }) 

  var f5 = spawn_(fun[] () -> Int { 
    var local_sum = 0 
    &local_sum += run_task(5) 

    var f = spawn_(fun[] () -> Int { return run_task(12) + run_task(16) }) 
    &local_sum += run_task(11) + run_task(15) 
    &local_sum += f.await() 

    return local_sum 
  }) 

  sum += f2.await() + f3.await() + f4.await() + f5.await() 
  &sum += run_task(18) 
  return sum 
} 
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fun run_work() -> Int { 
  var sum = 0 
  &sum += run_task(1) 

  var f2 = … 
  var f3 = … 
  var f4 = … 
  var f5 = … 

  sum += f2.await() + f3.await() + f4.await() + f5.await() 
  &sum += run_task(18) 
  return sum 
} 
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  var f2 = spawn_(fun[] () -> Int { 
    var local_sum = 0 
    &local_sum += run_task(2) 

    var f = spawn_(fun[] () -> Int { return run_task(7) }) 
    &local_sum += run_task(6) 
    &local_sum += f.await() 

    &local_sum += run_task(13) 
    &local_sum += run_task(17) 
    return local_sum 
  }) 
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  var f3 = spawn_(fun[] () -> Int { 
    return run_task(3) + run_task(8) 
  })
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  var f4 = spawn_(fun[] () -> Int { 
    var local_sum = 0 
    &local_sum += run_task(4) 

    var f = spawn_(fun[] () -> Int { return run_task(10) }) 
    &local_sum += run_task(9) 
    &local_sum += f.await() 

    &local_sum += run_task(14) 
    return local_sum 
  })
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  var f5 = spawn_(fun[] () -> Int { 
    var local_sum = 0 
    &local_sum += run_task(5) 

    var f = spawn_(fun[] () -> Int { return run_task(12) + run_task(16) }) 
    &local_sum += run_task(11) + run_task(15) 
    &local_sum += f.await() 

    return local_sum 
  })
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async/await model
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async vs sequential

fun concurrent_greeting() { 
  var f = spawn { 
    print("Hello, concurrent world!") 
  } 
  // do some other things... 
  f.await() 
} 

fun regular_greeting() { 
  print("Hello, sequential world!") 
  // do some other things... 
} 
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async vs sequential

fun concurrent_greeting() { 
  var f = spawn { 
    print("Hello, concurrent world!") 
  } 
  // do some other things... 
  f.await() 
} 

fun regular_greeting() { 
  print("Hello, sequential world!") 
  // do some other things... 
} no function colouring
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fun example() { 
  A() 

  var f = spawn { C() } 
  B() 
  f.await() 

  D() 
} 

spawn/await = operation
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fun example() { 
  A() 

  B_and_C() 

  D() 
} 

spawn/await = operation

fun B_and_C() { 
  var f = spawn { C() } 
  B() 
  f.await() 
} 
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1. use of abstractions

functions can encapsulate concurrency
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2. recursive decomposition

decomposition through functions
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program
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recursive decomposition 

functions all the way down
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3. regular shape

one entry point, and one exit point 
one entry thread, one exit thread 

one entry stack, one exit stack
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4. local reasoning

same as with function calls 

Hylo ❤ local reasoning
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reasonable concurrency
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5. soundness and completeness

same as in structured programming
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Implementation details 4
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fun example() { 
  A() 

  var f = spawn { C() } 
  B() 
  f.await() 

  D() 
} 
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C

B

A D

concurrency design
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A B D

C

pre1 t1 cont

pre2 t2 cont

thread 1

thread 2

at runtime
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A B D

C

pre1 t1 cont

pre2 t2 cont

thread 1

thread 2

at runtime
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A B D

C

pre1 t1 cont

pre2 t2 cont

thread 1

thread 2

at runtime
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A B D

C

pre1 t1 cont

pre2 t2 cont

thread 1

thread 2

at runtime
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A B D

C

pre1 t1 cont

pre2 t2 cont

thread 1

thread 2

at runtime
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A B

DC

pre1

t1 contpre2

t2 contthread 1

thread 2

at runtime
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using boost::context

stackfull coroutines
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stack

thread 1

thread 2

coro

A
B

D

C

thread hopping



@ Lu cTe o @ t e c h h u b . s o c i a l

thread hopping

start thread ≠ end thread
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2. 
no threads when spawning

execute task inside await
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stack

thread 1

thread 2

A
B

DC

other work

inplace execution
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3. 
copyable futures

 multiple awaits waiting on one task
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A() 

var f1 = spawn { C() } 
var f2 = f1 

// pass f2 to a different thread 
B() 

… 
f1.await() 

D() 

… 
f2.await() 

D2() 
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at runtime

A B D

C

pre1 t1 cont

pre3 t3 cont

thread 1

thread 3

B’ D2pre2 t2 contthread 2
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suspend

temporary join the work pool 
possible thread hopping on resume
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Asynchrony 5
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fun fwrite(_ data: MemoryAddress, _ size: Int, _ count: Int, _ stream: File) -> Int

synchronous function
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fun fwrite(_ data: MemoryAddress, _ size: Int, _ count: Int, _ stream: File) -> Int

asynchronous function
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asynchrony 
is abstracted away
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asynchrony / concurrency 
is abstracted away
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fun process_image(_ image: Image) -> ImageResult

abstracting concurrency

is it synchronous?

using multiple threads?
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1. use of abstractions

abstractions can be used as operations
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fun handle_incoming_connection(_ connection: HttpConnection) { 
  do { 

    // Read the HTTP request from the socket. 
    let request = try get_request(connection) 
    request.validate() 
    // Handle the request. 
    let response = try handle_request(request) 
    // Send back the response. 
    send_response(response) 

  } catch InvalidRequestError(let details) { 
    send_response(BadRequestResponse(details), to: connection) 
  } catch CancelledError { 
    send_response(GatewayTimeoutResponse(), to: connection) 
  } catch { 
    send_response(InternalServerErrorResponse(), to: connection) 
  } 
}

local reasoning
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fun get_request(_ connection: inout HttpConnection) throws: HttpRequest { 
  // Do the reading on the network I/O scheduler. 
  net_scheduler.activate() 

  // Read the incoming data in chunks, and parse the request while doing it. 
  var parser: HttpRequestParser 
  var buffer = MemBuffer(1024*1024) 
  while !parser.is_complete { 
    let n = connection.read(to: &buffer) // may be an async operation 
    &parser.parse_packet(buffer, of_size: n) 
  } 

  // Done reading; switch now to main scheduler. 
  main_scheduler.activate() 
  return parser.request 
}

local reasoning
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concurrency is an 
implementation detail
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Analysis 6
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1. modelling concurrency

structured concurrency 
easy to express concurrency 
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2. safety

no race conditions 
no additional synchronization 
forward progress guarantee 

no deadlocks
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3. performance

no blocking waits 
small spawn / await synchronisation 
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4. stack usage

small stack for worker threads 
# coro ~ # threads => not a lot of stack needed 

small stacks for thread hopping 
=> stack usage is decent
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5. interoperability

no thread-local-storage 
harder to interop with external modules 

(may require sync-wait)
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Conclusions 7
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from principles 
to practice

approach
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structured programming 
concurrency 

threads & stacks

principles
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modeling concurrency

concurrency = expressing constraints 
only 3 possibilities at runtime 

design time: 4 basic constraints
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concurrency in Hylo

easily express concurrency with spawn / await 
no need for a different style 

no function colouring 
no need for additional synchronisation 

structured concurrency
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concurrency in Hylo

abstracting concurrency details 
local reasoning 

reasonable concurrency
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additional benefits

safety: no race conditions, no deadlocks 
performance: generally fast, scalable, no oversubscription 
memory: decent stack consumption
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Hylo concurrency

simple syntax / semantics 
concurrent code ~ sequential code 

concurrency can be abstracted 
structured concurrency 

local reasoning
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Hylo concurrency

simple syntax / semantics 
concurrent code ~ sequential code 

concurrency can be abstracted 
structured concurrency 
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Hylo concurrency

simple syntax / semantics 
concurrent code ~ sequential code 

concurrency can be abstracted 
structured concurrency 

local reasoning
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reasonable concurrency
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